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Binary Analysis Process

• Up to now we know how ELF and PE files are structured

• but the question remains: how do we analyse ELF/PE files?
 Or any other binary

• A possible flow can be:
 File analysis (file, nm, ldd, content visualization, foremost, binwalk)
 Static Analysis (disassemblers and decompilers
 Behavioral Analysis (strace, LD_PRELOAD)
 Dynamic Analysis (debuggers)
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Questions to answer

• What type  of file we have?
 Are there hidden contents?

• What is the architecture?
 Is it 64/32 or ARM7/ARM9/ARM9E/ARM10?

• Where is the starting address?

• What the main function does?

• What will the program will actually do?
 What are its control structures
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Disassembler basics with ghidra

• ghidra is a open source tool, doing Disassembly and Static Analysis
 Has support for Dynamic Analysis (debug)
 Works on Windows, Linux and macos
 Java based

• Not the most important tool, but is gaining a huge traction
 It’s free and very powerful with a huge number of platforms and a fine decompiler

• Roles:
 Disassembler
 Decompiler
 … complete SRE framework
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Top menu and tools for quick access.
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Executable Structure (ELF, PE…)

All that was previously addressed can be 
inspected here.

Particular relevant to check content of 
additional sections, .got .symtab 
and .dynamic

Clicking on the file name will present the 
header, which contains the entry point.
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Functions declared in the code. Not only the user defined 
functions, but also additional ones injected by the  compiler, or 
required to the OS and linker.

Exports are functions declared in the binary file, which are 
available for use by another programs. That is: a name that points 
to some code.

Imports are functions used from external libraries. It includes the 
libraries required for the resolution of the said names.
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Data types are methods to organize and represent memory in the 
scope of the program address space. While developing a program 
we call these as Enums or Structures.

By clicking on the low arrow we can define new structures. The 
interface will ask us to state a name, and then add fields with a 
type. The type can be a basic one (int, short, double, or a complex 
one)

In File -> Parse C Source we can include a C header (.h) with types 
directly to our program
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Listing view of the program segments.

The different bytes are displayed according to their type. Code is 
disassembled and the instructions are presented. For x86, the 
Intel format is used by default

The format is something like:
Address     bytes     interpretation        comments
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Decompiled view of the current selected function (in the listing 
view)

At first stage the decompiled view can be complex. The trick is to 
rename function/variable names (pressing L)  and setting the 
correct data types for arguments and variables (CTRL-L). Ghidra 
will propagate types and update the listing view and decompiler 
view.

Be aware that the decompiler may not be fully reliable as perfect 
Decompilation is not always possible.
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Calls to a function or from the current function are presented in 
the bottom

Listing view  presents References to 
memory locations, which are locations 
where code refers to a given memory 
address.

May be used to identify location of 
arguments, function callers or data chunks 
used in the program

Listing view  presents functions with name, 
if the name is in the .dynamic or .symtab. 

Otherwise, it will name functions as 
FUN_ADDRESS. 

Functions can be identified by the symbols 
associated with an address or with 
assembly instructions. Functions are at 
address that are called and usually start by 
a stack ini
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Tools can find functions by the symbols 
associated with an address or by analyzing 
the code. 

Functions are at address that are called and 
frequently (but not always) start by a stack 
initialization block, and end with RET.
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In Menu->Window->Function Graph

A logical structure of the function is 
presented. This is generated by interpreting 
the branches that segment the function 
code.

Called: Control-Flow Graphs
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In Menu->Window->Function Call Graph

A logical structure of the program is 
presented, starting the current function. At 
each node we can Show/Hide Calling 
functions or Called functions. We can 
effectively have a full representation of the 
program structure.

HINT: It makes much more sense with 
symbols or renamed functions

Called: Call Graphs
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CFGs

• It is useful to think of machine code in a graph structure, called a control-
flow graph 

• A node in a CFG is a group of adjacent instructions called a basic block: 
 The only jumps into a basic block are to the first instruction
 The only jumps out of a basic block are from the last instruction 
 I.e., a basic block always executes as a unit

• Edges between blocks represent possible jumps
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CFGs

• Basic block a dominates basic block b if every path to b passes through a first
 strictly dominates if a != b

 Typical for a decision or preparation block

• Basic block b post-dominates a if every path through a also passes through b later 
 Typical for a wrap up or clean up block
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Disassembly

• Process involves analyzing the binary, converting binary code to assembly
 But “binary” is just a sequence of bytes, that must be mapped in the scope of a given architecture
 Conversion depends on many factors, including compiler and flags

• Process is not perfect and may induce RE Analysts in error
 Present instructions that actually do not exist
 Ignore instructions that are in the binary code

• Main approaches:
 Linear Disassembly
 Recursive Disassembly
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Linear Disassembly

• Simplest approach towards analyzing a program: Iterate over all code 
segments, disassembling the binary code as opcodes are found

• Start at some address and follow the binary
 Entry point or other point in the binary file
 Entry point may not be known

• Works best with:
 binary blobs such as from firmwares (start at the section “beginning”)
 objects which do not have data at the beginning
 architecture uses variable length instructions (x86)

20



João Paulo Barraca REVERSE ENGINEERING

Linear Disassembly

21

It is vital to define the initial address for 
decompiling.

An offset error will result in invalid or 
wrong instructions being decoded.

Linear disassembly will also try to 
disassemble data from the binary as if it 
was actual code.

Linear Disassembly is oblivious to the 
actual Program Flow.

With x86, because it each opcode has a 
variable length, the code tends to auto 
synchronize, but the first instructions will 
be missed
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Linear Disassembly
Issues
• With ELF files in x86, linear disassembly tends to be useful

 Compilers do not emit inline data and the process rapidly synchronizes
 Still, padding and alignment efforts may create some wrong instructions

• With PE files, compilers may emit inline data and Linear Disassembly is not adequate
 Inline data: data (not code) together with code
 Every time data is found, disassembly becomes desynchronized

• Other architectures (ARM) and binary objects usually are not suited for Linear 
Disassembly

 Obfuscation may include code as data, which is loaded dynamically
 Fixed length instruction sets will not easily synchronize
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Linear Disassembly
So why is it useful?

• Code in the binary blob may be executed with a dynamic call
 Some JMP/CALL with an address computed dynamically and unknown to the static analyzer

• Linear Disassembly will decompile everything:
 whether or not it is called - May be useful to uncover hidden program code

 even if the binary blob is not a structured executable – Boot sector, firmware

• Readily available with simple tools: objdump and gdb
 Gdb memory dump (x/i) will also use Linear Disassembly
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Recursive Disassembly
More complex approach

• Disassembles code since an initial point, while following the control flow
 That is: follows jmp, call and ret

• IF start point is correct, or it synchronizes rapidly, flow can be fully recovered
 This is the standard process for more complex tools such as ghidra and IDA

• Goes around inline data 
 As no instruction will exist that will make the program execute at such address

 Well… control flow can easily be forged with ((void (*)(int, char*)) someaddress)()
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Example of a program without visible structure being 
decompiled from the start.

Disassembler stops as invalid operations are found. The 
entry point may be wrong (this may be data and not 
code), the architecture may be wrong (or both). 
More insight (or trial and error is needed)
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Function detection

• Functions frequently include known prolog and epilogues
 Prolog: setup the stack and optionally setup Stack Guard Canaries
 Epilog: optionally check the canaries and release stack

• This information may be used to determine function boundaries
 But it is architecture and compiler dependent

• Alternatives:
 Pattern matching (automatic, done by disassemblers) can also recover functions
 Exception handling code in the .eh_frame section
 gcc intrinsics to cleanup stacks with exceptions 

 __attribute__((__cleanup__(f)))
  __builtin_return_address(n)

João Paulo Barraca 26
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Function detection
Typical Prologue with Stack Guard

27

Stack allocation code
- Stores RBP
- Makes RBP = RSP
- Allocates 0x30 bytes

Canary setup
- Fetches value from FS:[0x28] to RAX
- Stores value at RBP+local_10 (top of 

the local stack)
- Erase RAX

Stores register in stack
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Function detection
Typical Epilogue with Stack Guard

28

Fetches the Canary

Deallocate stack and return to caller

- XORs the Canary with reference value
- This sets the Zero flag if they are equal 
(No corruption)
- Jumps to end of program, or crashes 
the program with __stack_chk_fail
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Function detection
Non Returning Functions

29

• Some functions, like exit or abort, are non-returning functions.
 Such functions do not return to the caller after executing. 

 Instead, they do drastic things like halting the execution of the program.

• If the SRE tool does not know that a function is non-returning, it 
will assume that bytes after the function are instructions and 
attempt to disassemble them.
 This should not happen as one of the instructions would interrupt execution
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Function detection
Non Returning Functions

30

0000000000003a9 <loopForever>: 
3a9:   55                      push   %rbp 
3aa:   48 89 e5                mov    %rsp,%rbp 
3ad:   48 83 ec 10             sub    $0x10,%rsp 
3b1:   89 7d fc                mov    %edi,-0x4(%rbp) 
3b4:   8b 45 fc                mov    -0x4(%rbp),%eax 
3b7:   48 8d 15 62 0f 00 00    lea    0xf62(%rip),%rdx 
3be:   89 c6                   mov    %eax,%esi 
3c0:   48 89 d7                mov    %rdx,%rdi 
3c3:   b8 00 00 00 00          mov    $0x0,%eax 
3c8:   e8 f3 fe ff ff          call   2c0 <printf@plt> 
3cd:   eb e5                   jmp    3b4 
<loopForever+0xb>

00000000000003cf <printInputThenLoop1>: 
3cf:   55                      push   %rbp 
3d0:   48 89 e5                mov    %rsp,%rbp 
a
3d7:   48 89 7d f8             mov    %rdi,-0x8(%rbp) 
3db:   48 89 75 f0             mov    %rsi,-0x10(%rbp) 
3df:   48 8b 55 f0             mov    -0x10(%rbp),%rdx 
3e3:   48 8b 45 f8             mov    -0x8(%rbp),%rax 
3e7:   48 8d 0d 39 0f 00 00    lea    0xf39(%rip),%rcx
3ee:   48 89 c6                mov    %rax,%rsi 
3f1:   48 89 cf                mov    %rcx,%rdi 
3f4:   b8 00 00 00 00          mov    $0x0,%eax 
3f9:   e8 c2 fe ff ff          call   2c0 <printf@plt>a 
3fe:   bf 01 00 00 00          mov    $0x1,%edi 
403:   e8 c8 fe ff ff          call   2d0 <loopForever@plt> 
408:   ff                      (bad) 
409:   ff                      .byte 0xff
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Calling Conventions

• Compilers handle the function calling processes differently
 They use several conventions

 Adapted to how programmers use the languages (number of arguments)
 Adapted to number of registers and other architecture details

• These dictate:
 How arguments are passed from caller to the callee
 How return codes are passed to the caller
 Who allocates the stack, and how
 Who stores important registers such as the Program Counter
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Calling Conventions
cdecl 

• Originally created by Microsoft compilers
 Widely used in x86, including GCC
 Standard method for most code in x86 environments

• Arguments: passed in the stack, in inverted order (right to left)
 First argument is pushed last

• Registers: Mixed
 Caller saves IP, A, C, D
 Callee saves BP, and others and restores RIP
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Calling Conventions
cdecl 

33

Allocate stack

Add two arguments. 
Array at EBP-20 and argument at EBP+8

Restore EBP, EIP

Prepare arguments to be sent

Call the function. Automatically stores  EIP in stack

Deallocate stack

Add 4 to EAX  (EAX contains return from callee)
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Calling Conventions
stdcall

• Official call convention for the Win32API (32 bits)

• Arguments: passed in the stack from right to left
 Additional arguments are passed in the stack

• Registers: Callee saves
 Except EAX, ECX and EDX which can be freely used

• Stack Red Zone: Leaf functions have a 128 byte area kept safe
 Which doesn’t need to be allocated by leaf. Allocated by callee
 Can be used for local variables, and avoids the use of two operations (sub rsp, add rsp)
 Leaf functions are functions that do not call others
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Calling Conventions
stdcall 
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Allocate stack

Add two arguments. 
Array d at EBP-20 and argument a at EBP+8

Free Stack

Restore RIP

Prepare arguments to be sent. Right ones  first

Call the function. Automatically stores  EIP in stack

Add 4 to EAX (EAX contains return from callee)
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Calling Conventions
fastcall

• Official call convention for Win32API  64bits

• Arguments: left to right, first arguments as registers
─ Additional arguments are passed in the stack

• Registers: Caller saves

• Stack Shadow Zone: Leaf functions have a 32 byte area kept safe 
─ Which doesn’t need to be allocated
─ Can be used for local variables, and avoids the use of two operations (sub rsp, add rsp)
─ Leaf functions are functions that do not call others
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Calling Conventions
fastcall (32bits)

37

Adds (char) d[0] with a
a at EBP-36
d[0] at EBP-20

Stores arguments to stack

Restore EIP

Prepare arguments to be sent

Call the function. Automatically stores  IP in stack

Add 4 to EAX (EAX contains return from callee)

Allocate stack
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Calling Conventions

38

cdecl stdcall fastcall 
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Calling Conventions
Fastcall for 64bits (Windows)
• Official convention for x86_64 architectures with MSVC (Windows)

─ Mandatory if compiling for x86_64 in Windows

• Arguments: passed as RDX, RCX, R8, R9
─ Additional arguments are passed in the stack (right to left)

• Registers: Mixed
─ Caller save: RAX, RCX, RDX, R8, R9, R10, R11
─ Callee save: RBX, RBP, RDI, RSI, RSP, R12, R13, R14, and R15

• Stack Red Zone: Leaf functions have a 32 byte area kept safe, allocated by the callee
─ Can be used to store RDX, RCX, R8, R9
─ (Leaf functions are functions that do not call others)
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Calling Conventions
fastcall (64bits)

40

Add two arguments

Stores arguments to shadow

Restore RIP

Prepare arguments to be sent

Call the function. Automatically stores  IP in stack

Add 4 to EAX (EAX contains return from callee)

Free Stack
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Calling Conventions
System V AMD64 ABI
• Official convention for x64 architectures using Linux, BSD, Unix, Windows

• Arguments: passed as RDI, RSI, RDX, RCX, R8, R9
─ Additional arguments are passed in the stack

• Registers: Caller saves
─ Except RBX, RSP, RBP, R12-R15 which callee must save if they are used

• Stack Red Zone: Leaf functions have a 128 byte area kept safe 
─ Which doesn’t need to be allocated
─ Can be used for local variables, and avoids the use of two operations (sub rsp, add rsp)
─ Leaf functions are functions that do not call others
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Calling Conventions
System V AMD64 ABI 

42

Leaf function uses stack directly (Shadow)

Adds (char) d[0] with a
d[0] is at RBP-32. d[1] at RBP-31…
a is at RBP-36

Restore RIP

Prepare arguments to be sent

Call the function. Automatically stores  RIP in stack

Add values. EAX will contain the result
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Calling Conventions
64bits

43

System V AMD64 ABI fastcall 
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Common Logic Structures

• It’s important to recognize basic flow control structures
─ Remember that the decompiler may be unreliable

• Basic structures (besides functions):
─ if else
─ switch case
─ for 
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Common Logic Structures
Conditional Branches (if else)

• Basic control-flow instructions: move execution to a defined address 
if a condition is true
─ Usually, one condition tested at a time. Complex If/else must be broken

• Assembly code is structed as a graph with tests and execution 
statements (the conditions body)

• x86 and most architectures have inherent support for many types of 
comparisons. 
─ In x86 this is the jXX family of instructions.
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Common Logic Structures
Conditional Branches (If else)

• Structure can be 
recognized by one or 
more conditional 
branches, without 
loops

• je: jump equal

• js: jump is sign

• …etc…
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Common Logic Structures
Switch case
• Structure can be recognized by several 

comparisons and jumps or jump table

• Observe the difference between what 
a programmer writes and what is 
produced
─ Switch is written as an atomic 

instruction, but it isn’t
─ Also, it mat be dangerous if breaks are 

missing

• test: compare two registers. Set 3 flags:
─ PF: Even number of bits
─ ZF: Zero
─ SF: Signed value

53



João Paulo Barraca REVERSE ENGINEERING

Common Logic Structures
loops
• For, while and 

do while are 
generally the 
same

• Identified by:
─ an index

─ an increment

─ a comparison

─ two jumps

54

Prepares stack

- r12d will contain the 
number of iterations
- ebx will be the counter

- Loop body

Jump to top of loop
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Defining Data Types

•One of the best ways to clean up the decompiled code is to apply data types. 

•You can define types manually through the Data Type Manager. 

•You can also have Ghidra help you by right-clicking on a variable in the decompiler 
view and selecting

– Auto Create (Class) Structure, or
– Auto Fill in (Class) Structure. 

•You can parse data types from it by selecting File → Parse C Source... from the Code 
Browser, or load gdt files with definitions (e.g. the jni_all.gdt file)
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Defining Data Types

void print_device_status(uint *dev)
{
  if (dev != (uint *)0x0) {
    puts("--- Device Status Report ---");
    printf("ID: 0x%08X\n",(ulong)*dev);
    printf("Name: %s\n",dev + 6);
    if (dev[1] == 1) {
      puts("Status: ONLINE");
      printf("Temperature: %.2fC\n",(double)(float)dev[2]);
      printf("IPv4: 0x%08X\n",(ulong)dev[4]);
    }
    else {
      printf("Status: OFFLINE (%d)\n",(ulong)dev[1]);
    }
    puts("----------------------------");
  }
  return;
}

56

void print_device_status(HardwareDevice *dev)
{
  if (dev != (HardwareDevice *)0x0) {
    puts("--- Device Status Report ---");
    printf("ID: 0x%08X\n",(ulong)dev->device_id);
    printf("Name: %s\n",dev->device_name);
    if (dev->current_state == STATE_ONLINE) {
      puts("Status: ONLINE");
      printf("Temperature: %.2fC\n",(double)dev->temperature);
      printf("IPv4: 0x%08X\n",(ulong)(dev->net_id).ipv4_addr);
    }
    else {
      printf("Status: OFFLINE (%d)\n",(ulong)dev->current_state);
    }
    puts("----------------------------");
  }
  return;
}

After Parsing a .h header
Or Defining the HardwareDevice Structure
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C++ code

• C++ is very popular, and adds an additional layer of complexity
─ A program doesn’t have functions, has methods
─ Methods have a shared context (the object)
─ Methods can be overridden due to inheritance
─ The this pointer commonly allows access to data outside the function 

stack
─ Constructors, new…?
─ Strings are complex objects
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C++ code

• this pointer
─ The “this” pointer plays a crucial role in the identification of C++ sections in the 

assembly code. It is initialized to point to the object used, to invoke the function, when 
it is available in non-static C++ functions. 

• Vtables
─ Eases runtime resolution of calls to virtual functions. 
─ The compiler generates a vtable containing pointers to each virtual function for the 

classes which contain virtual functions.

• Constructors and destructors
─ A member function which initializes objects of a class and it can be identified in 

assembly by studying the objects in which it’s created. 

João Paulo Barraca 58
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C++ code

• Runtime Type Information (RTTI) 
─ Mechanism to identify the object type at run. 
─ These keywords pass information, such as class name and hierarchy, to the class. 

• Structured exception handling (SEH)
─ Irregularities in source code that unexpectedly strike during runtime, terminating the 

program. 
─ SEH is the mechanism that controls the flow of execution and handles errors by isolating the 

code section where the unexpected condition originates. Inheritance 

• Inheritance 
─ allows new objects to take on existing object properties.
─ Observing RTTI relationships can reveal inheritance hierarchy

João Paulo Barraca 59
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hello1.cpp
A simple hello world
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hello1.cpp

61
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C++ code

62

No C++ class 
declarations, but C++ 
class use.

- Constructors
- Methods
- Destructors
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C++ code

63

Standard ASM code
with function 
invocation, using 
arguments in registers 
and values stored in the 
stack

Additional Hints related 
to exception handling
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C++ code

64

.eh_frame ELF section contains information about the multiple methods.

Required for unwinding frames, when iterating over the function frames. Contains language specific 
information, organized in Call Frame Information records
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C++ code

65

this is passed as an additional, hidden argument
In this case, in RDI as the method has no arguments
First argument of all non static class members
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